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SITE LICENSE AGREEMENT 
  
DEFINITIONS 
  
The Evaluator: 
The Evaluator is the individual, school, company, or organization evaluating the Curriculum. 
  
The Site: 
The location where the Curriculum will be evaluated. 
  
The Curriculum: 
Collectively, all version and format of the projects (teacher guides, student workbooks, resource files), pamphlets, or other publications or documents prepared by or on behalf of TechnoKids Inc.  
  
Evaluation Period: 
The “Evaluation Period” is ninety (90) days, beginning on the date the Evaluator downloads the Curriculum from TechnoKids Inc. 
  
  
ACKNOWLEDGMENTS 
  
The Evaluator acknowledges that the field of endeavor in which TechnoKids Inc. is engaged is highly competitive and that their success is and will be substantially based upon the Curriculum. The Evaluator 
acknowledges that TechnoKids Inc. is providing them with access to the Curriculum which has been developed at great expense and effort. The Evaluator agrees that the unauthorized disclosure of the Curriculum 
may result in irreparable harm to TechnoKids Inc. 
  
LICENSE GRANT 
  
TechnoKids Inc. agrees that the Evaluator shall be permitted, subject to the terms of this Agreement, to print, install, and use the Curriculum, during the Evaluation Period for the sole purpose of evaluating the 
Curriculum for purchase. The Evaluator acknowledges that when the Evaluation Period expires, the Agreement terminates automatically.  
  
AUTHORIZED USERS 
  
The Curriculum may be evaluated by the Evaluator only at the Site. 
The Curriculum may be disclosed only to persons at the Site having the need to know the information for the purpose of this Agreement.  
Access to print, install, and use the Curriculum shall be limited to those employees and agents of the Site that have a need to know for the purpose of this Agreement. 
Evaluator will use commercially reasonable efforts to restrict network or any other access to the Curriculum by anyone outside of Evaluator's facilities who are not authorized to evaluate the Curriculum.  
  
TERMS OF USE 
  
Evaluator agrees to treat the Curriculum as it does its own valuable and sensitive information of a similar nature. 
Evaluator has the right to print the Curriculum. Printing is limited to no more than two (2) copies of the project (teacher guides and student workbooks) for evaluation by Authorized Users at the Site.  
Evaluator has the right to install on no more than two (2) personal computers, workstations, or other digital electronic devices including wireless devices, the Curriculum, for evaluation by Authorized Users. 
Evaluator shall be solely responsible for all expenses incurred in the printing, installation, and use of the Curriculum during the Evaluation Period. 
  
RESTRICTIONS 
  
Evaluator is prohibited from making any copies of the Curriculum on magnetic media, such as a CD-ROM or DVD. 
Evaluator shall not remove any markings or notices of intellectual property rights from the Curriculum and shall ensure that all printed and digital files bear such marking or notices. 
Distance learning is prohibited. This restriction applies to use of the Internet, Intranet, and CD-ROM / DVDs. 
The Evaluator may not sell, lend, lease, rent, assign, or transfer the Curriculum to another party in any form. 
The Evaluator may not translate, reverse engineer, de-compile, disassemble, or create derivative works based upon the Curriculum or any part thereof. 
The Evaluator may not use or export the Curriculum to another country. 
The Evaluator shall not use the Curriculum as part of a course. 
  
OWNERSHIP 
  
Evaluator acknowledges that TechnoKids Inc. retains all ownership and intellectual property rights in and to the Curriculum, all derivative works created using the Curriculum and any related materials. TechnoKids 
Inc. reserves all rights not expressly granted herein. TechnoKids Inc. shall retain all applicable rights to copyrights, trademarks, patents, trade secrets, and all other intellectual property rights in the Curriculum. 
  
EXCLUSIONS OF WARRANTIES 
  
The Evaluator acknowledges that the Curriculum is provided for evaluation purposes "as is" without any warranty of any kind. TechnoKids Inc. expressly excludes all express or implied warranties relating to the 
Curriculum, including, without limitation, warranties of merchantability, fitness for a particular purpose, or non-infringement. The Evaluator acknowledges that the entire risk arising out of use or performance of the 
Curriculum remains with the Evaluator. 
  
LIMITATIONS OF LIABILITY 
  
Evaluator agrees that TechnoKids Inc. shall not be liable for any direct, indirect, incidental, special or consequential damages, damages for loss of profits, revenue, data or data use, incurred by the Evaluator or any 
third party, whether in an action in contractor or tort, even if TechnoKids Inc. has been advised of the possibility of such damages. 
  
SUPPORT SERVICES 
  
At its sole discretion, TechnoKids Inc. may provide curriculum support for the Curriculum to the Evaluator. However, TechnoKids Inc. shall not be obligated to provide curriculum support for the Curriculum, to ensure 
the proper operations or compatibility of the Curriculum with any software or hardware, or correct any errors or defects in the Curriculum. 
  
TERMINATION 
  
This Agreement shall continue for the duration of the Evaluation Period. However, it will terminate if the Evaluator fails to comply with any of its terms and conditions.  
If any breach of this Agreement by Evaluator occurs, TechnoKids Inc. may terminate this Agreement, whereupon this Agreement and all rights granted to Evaluator herein shall immediately cease. 
The Evaluator agrees, upon termination, to promptly destroy any printed Curriculum and delete all Curriculum files from computers. In addition, Evaluator shall upon request promptly provide TechnoKids Inc. a letter 
certifying the destruction of the Curriculum, and shall take all reasonable steps within its power, alone or in conjunction with TechnoKids Inc. to prevent any further unauthorized use or disclosure of such Curriculum. 
  
GENERAL TERMS 
  
The Evaluator accepts the Agreement and understands that any violation will be prosecuted to the full extent of local law. 
If any provision of this Agreement is declared by a court of competent jurisdiction to be invalid, illegal or unenforceable such provisions shall be severed from the licensing agreement, however, the other provisions 
shall remain in full force and effect. 
All trademarks acknowledged.  
No documentation provided by TechnoKids Inc. may be copied without written permission from TechnoKids Inc. unless produced under the terms of the Agreement. 
TechnoKids Inc. reserve the right to alter licensing conditions at any time, without prior notice. No terms or conditions wil l affect the Evaluator’s rights as defined under Canadian law. 
At any time during or after the Evaluation Period, the Evaluator may purchase a license to use the Curriculum at the Site. However, TechnoKids Inc. acknowledges that there is no obligation for the Evaluator to 
purchase the Curriculum. 
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Project Overview 
 

Introduction to TechnoReport 

 

In this project, students write a report for the environmental newsletter “Friends of the Planet”. 

They acquire word processing skills enabling them to write a report about an endangered 

species. To begin, they acquaint themselves with the Microsoft Word environment, specifically 

the ribbon, which allows them to edit the appearance of a report. Selecting an endangered 

species to research, students gather relevant facts about the threats against wildlife. Using this 

information, they produce a report identifying the problem and possible solutions to the 

diminishing populations. To complete this project the document is formatted to appear like a 

newspaper, with columns, pictures, and eye-catching text. 

 

It is time to raise awareness. Write a report on an endangered species! 

 

 

Students complete the following tasks: 

 

 In session 1, students prepare to write a report on an endangered species. To begin, they 

learn about wildlife at risk of extinction. Afterwards, they examine Microsoft Word to 

become familiar with how to use the ribbon to perform basic word processing tasks. They 

apply this knowledge to edit a report on the Giant Panda, an animal who is at risk of 

becoming extinct. 

 In session 2, students expand their awareness of endangered species around the world 

by visiting several bookmarked sites using Microsoft Internet Explorer. Selecting a topic to 

study, students gather relevant data to be used to write a report for the "Friends of the 

Planet" newsletter. As a class, the issues of plagiarism are discussed. Students are then 

taught the importance of citing the source of information. 

 In session 3, students continue their online research. They collect three images of their 

topic. Learning how to cite the source of a picture, they continue to record the location 

of data gathered. 

 In session 4, students write their report about an endangered species. To begin, they 

practice rewording text to put it into their own words by editing the report about the 

pallid bat. Once this activity is complete, students apply their newfound skills to reword 

the facts to produce their own report. 

 In session 5, students improve the appearance of their report. The report begins to take 

on the look of a newspaper article by changing the paragraph formatting to columns. 

Students then customize the appearance of text by setting the alignment, as well as to 

format the font, style, size, and color. 

 In session 6, students add the final element to their report – pictures! With the inclusion of 

visual media, students learn about text wrap. They explore various layout options to 

select the one that is right for the report. Things are wrapped up after the changes have 

been saved and the document is sent to the printer. These contributions to the Friends of 

the Planet newsletter will surely educate readers about endangered species. 
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SESSION 4 
Write the Report 

In this session, students write their endangered species report. To begin, they 

practice rewording text to put it into their own words by editing the report about 

the Pallid Bat. Once this activity is complete, students apply their newfound skills 

to re-word the facts to produce their own endangered species report. 

Assignment 8: Proofread the Pallid Bat Report 

Assignment 9: Write Your Own Report 

Session 4 Skill Review 

Session 4 Extension Activity: Make an Animal Habitat 
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Session 4: Write the Report 

GETTING STARTED 

Overview 

In this session, students write their endangered species report. To begin, they practice rewording 

text to put it into their own words by editing the report about the Pallid Bat. Once this activity is 

complete, students apply their newfound skills to re-word the facts to produce their own 

endangered species report. 

 

Materials 

 Microsoft Word 2010 

 Pallid Bat template 

 Pallid Bat sample file 

 Microsoft Internet Explorer 

 Microsoft Word Review tab flashcards (Optional) 

 Session 4 Skill Review (Optional) 

o Session 4 Skill Review instructions 

o Mountain Gorillas template 

o Mountain Gorilla edit 

 TechnoReport Rubric (Optional  - Located in Session 7) 

 

Teacher Preparation 

 The Report folder must be made available to students because it contains the Pallid Bat 

template needed for this session. 

 (Optional) Print the flashcards listed in the materials list for this session. Refer to the 

Preparing to Teach section of this guide for complete instructions. 

 

Teaching Strategy 

 

In this session, students learn how to re-word their facts to produce a report about an 

endangered species. Explain scenario to students. 

 

 You cannot pretend that the facts you copied and pasted from the Internet are your 

own. That would be plagiarism. Instead, you must rewrite the facts to put them into your 

own words. 

 

By adding, deleting, and changing words, you can turn each fact into a sentence that 

makes sense. Sometimes you may come across words you do not know. You can use the 

thesaurus or a dictionary to help you find another word. 

 

When you are done, it is always a good idea to check spelling and grammar. Although 

in this session, you will use spell check, it is important to realize that it will not find all the 

mistakes. You still need to read over your work. 



TECHNOREPORT 

4-2  TECHNOKIDS INC. 

 

Assignment 8 Proofread the Pallid Bat Report 

 

In this assignment, students learn how to rewrite facts and put them into their own words. This is a 

good opportunity to discuss the issue of plagiarism. 

 

 

Assignment 9 Write Your Own Report 

 

In this assignment, students apply their knowledge to rewrite the facts in their report. 

 

 

About Assessment 

 

If you plan to grade the work completed in TechnoReport you may wish to refer to the 

TechnoReport rubric located in Session 7. One section of the rubric contains criteria for the report 

portion of the project, completed in Session 4, Session 5, and Session 6. This document is 

available as a customizable Microsoft Word file in the TechnoReport Resource folder if you 

would like to make changes. 

 
REPORT 1 2 3 4 Mark 

Content Many facts are 

illogically sequenced 

and worded 

unclearly. 

A few facts are 

illogically 

sequenced and 

worded unclearly. 

The facts are 

logically sequenced 

and worded clearly. 

The facts are logically 

sequenced and worded 

clearly.  

The report includes 

insight into the 

animal/plant. 

 

Pictures There are less than 

three pictures and 

some are not 

appropriate to the 

topic. 

There are three 

pictures but some 

are not appropriate 

to the topic. 

There are three 

pictures and each is 

appropriate to the 

topic.  

Pictures are limited 

in variety. 

Pictures illustrate a 

variety of facts. There 

are three pictures and 

each is appropriate to 

the topic.  

 

Spelling More than two words 

are spelled 

incorrectly. 

Two words are 

spelled incorrectly. 

One word is spelled 

incorrectly. 

All words are spelled 

correctly. 

 

Grammar There are major 

punctuation and 

capitalization errors. 

There are several 

minor punctuation 

and capitalization 

errors. 

There are only a few 

minor punctuation 

and capitalization 

errors. 

There are no 

punctuation and 

capitalization errors. 

 

Layout Pictures and text are 

not arranged 

attractively in 

columns. 

Pictures and text are 

arranged somewhat 

attractively in 

columns. 

Pictures and text 

are arranged 

attractively in 

columns. 

Pictures and text are 

arranged attractively in 

columns, with additional 

formatting included. 

 

TIMELINESS More than two days 

late. 

Two days late. One day late. Handed in on due date.  
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Lesson Plan 

Assignment 8 - Proofread the Pallid Bat Report 

 Open Microsoft Word. 

 Open the Pallid Bat Report document. 

 Read the facts about the pallid bat. Draw attention to the four areas of the document 

that require revision. 

 Edit the report: 

o Rewrite two sentences by deleting information about the pallid bat. 

o Turn phrases into complete sentences about the pallid bat by deleting, adding, 

and changing text. 

o Use the thesaurus to replace words in a sentence. 

o Use the dictionary to learn the meaning of a word. Change the word to another 

one that is easier to understand. 

o Use the spell check feature of Microsoft Word to correct errors. 

 Save the document as Pallid Bat Edit. 

 Print the document. 

 Exit Microsoft Word. 

 

Assignment 9 - Write Your Own Report 

 Open Microsoft Word. 

 Open the endangered species report document. 

 Rename the document as report using the Save As option. 

 Apply knowledge to re-word the facts to produce a report. 

 Save changes and Exit Microsoft Word. 
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to complete 

each task independently. 

 

Technical Skills: 

 

Operating Environment 

 open and close a program 

 open a saved document 

 save a document 

 rename a document using Save As 

 

Word Processing 

 add and delete text 

 use the thesaurus and dictionary 

 use spell check to correct grammar and spelling errors 

 

Applied Technology 

 edit the content of a document 

 

 

 

 

 

 

 



TECHNOREPORT  SESSION 4 

TECHNOKIDS INC.  4-5 

Assignment 8: Proofread the Pallid Bat Report 
 

 

 
 

 

 

Open Microsoft Word 

 Open Microsoft Word. 

 Click the File tab and choose Open. 

 Go to the Report folder (ask your teacher how to do this). 

 Select the Pallid Bat document and click Open. 

 

 

 

  

You do not want to plagiarize anyone. Plagiarism is when you take someone 

else's work and pretend it is your own. It is illegal. 
 

For this reason, you need to take the facts you found on the Internet and put 

them into your own words. This is a difficult job.  

There are four problems that you may have when re-

wording your facts: 
 

There is too much information: You will need to cut out 

words to make each sentence sound better. 
 

The text is not in sentences: in this case, you will need to 

add, delete, or change the words to have them make 

sense. 
 

The words used are not words you would normally use: in 

this case, you can use the thesaurus to find another word 

that you understand and that means the same thing. 
 

Words may not be ones that you know: Sometimes you will 

need to use a dictionary to find out the meaning of an 

unknown word. Once you know what the word means you 

can re-word the fact. 
 

You will edit the report on the Pallid Bat. Editing this report is 

good practice so that you can write your own.  

S
A
M

P
LE
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Read the Facts about the Pallid Bat 

 

 

 

 

  

The Pallid Bat report has already been 

edited in places. You need to finish it. Edit 

the parts in blue, brown, purple, and red. 
 

First, read the report and look at the four 

common problems. 

These words are not ones 

you would use in your 

writing. Use the thesaurus 

to find other words that 

mean the same. These facts are not in 

sentences. Words need to 

be added to have this 

information make sense. 

These sentences are very 

long. They have TOO 

much information. Words 

need to be added, 

deleted, and changed to 

help the sentences make 

sense. 

You do not know the 

meaning of these words. 

You need to use the 

dictionary to look them 

up. Once you know what 

the words mean you can 

rewrite the sentences. S
A
M

P
LE
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Problem: Too Much Information 

 

 Delete the underlined words in the sentences under the Appearance heading. 

The total length is 92 to 135 millimeters, tail length is 35 to 53 millimeters, hind foot 

length is 11 to 16 millimeters, ear length is 21 to 37 millimeters, forearm length is 45 

to 60 millimeters, and skull length is 18.6 to 24 millimeters. Females tend to be 

larger than males (mass 13.6 to 24.1 grams in males, 13.9 to 28.0 grams in 

females). 

 Now read the sentences. What punctuation do you need to remove to have the 

sentences make sense? Make the changes. 

 

 

 

 

 

 

 

Problem: Facts are Not in Sentences 

 

 Add the words "The pallid bat lives in", beside the fact Deserts and canyons in the first 

fact. 

 Add the words "In the Daytime it roosts" to make the second fact make sense. 

 Delete the words less often. In their place, add "Sometimes it lives" to make the third fact 

make sense. 

 Add the words "At Nighttime the pallid bat roosts" to make the fourth fact make sense. 

 Now reread those sentences. What punctuation or capitals do you need to correct to 

have the sentences make sense? Make the changes. 

 

  

Many times the facts are not written in 

complete sentences. You will need to add, 

delete, and change some words! 

You want the report to be interesting to read. 

Sometimes there can be too much 

information in a fact. Delete it! 

S
A
M

P
LE
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Problem: The Words are not Ones You Would Use 

 

 Under the Appearance heading, double click on the word drab. 

 Click the Review tab. Find the Proofing group.  

 

 

 Click the Thesaurus command. 

 Look in the Research pane at the list of suggestions. 

 

 When you find a word to replace drab, move the mouse pointer OVER the word and 

click on the arrow on the right edge. DO NOT CLICK THE WORD! 

 Choose Insert from the list. 

 
 

 Under the Appearance heading, double click on the word base. 

 Click the Thesaurus command. 

 View the results and choose a different word. 

 

You may not use the word drab or base. The 

thesaurus will help you to find other words that 

you are more likely to use when you write. 

 

TIP: Pick a word that fits with 

the sentence. For example, 

dull makes sense but somber 

does not. 

TIP: If you click on the word, a list 

of synonyms will show up. If this 

happens, click the Back button. 

S
A
M

P
LE
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Problem: You Do Not Know the Meaning of the Word 

 

 Under the Appearance heading, double click on the word pelage. 

 Click the Thesaurus command. 

 In the Research pane, click the Thesaurus arrow. 

  All Reference Books list, and choose Encarta Dictionary: English (North America). 

 

 Read the definition. [a mammal’s coat of fur, hair, or wool].  

 Replace the word pelage with the word coat. 

 KEEP THE RESEARCH PANE OPEN. 

 Under the Family heading, double click on the word volant. 

 Type volant into the Search for bar in the Research pane and then press ENTER. 

 Read the definition. 

 

 Replace volant in the report with words that are easier to understand and that make 

sense in the sentence. 

 

You may not know the meaning of some words. 

The dictionary will help you out. 

S
A
M

P
LE
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Spelling & Grammar Check 

 

 Click the Review tab. Find the Proofing group.  

 Click Spelling & Grammar. 

 To use it: 

o Fix a Mistake: Click on the correction in the Suggestions pane, then click Change. 

o Type in a Correction: Make a change in the upper window, then click Change. 

o Ignore a Suggestion: If the suggestion is not right, click Ignore Once or Ignore 

Rule. 

 

 Click OK when the spell check is complete. 

 

Save Changes to the Document 

 Click the File tab and then click Save As. 

 Go to your student folder. 

 Name the document Pallid Bat edit and click Save. 

 

 

Print the Document and then Exit Microsoft Word 

 Click the File tab and choose Print. 

 Click the Print button. 

 Exit Microsoft Word. 

 

It is important to make sure you have the 

right spelling and punctuation. Microsoft 

Word has a spelling feature that will help you 

fix most problems. However, it is still a good 

idea to read over your work. 

S
A
M

P
LE
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Assignment 9: Write Your Own Report 
 

Rewrite the facts to make a report about an endangered species. 

 

Open Microsoft Word 

 Open Microsoft Word. 

 

Open the Report 

 Click the File tab and choose Open. 

 Go to the place where you saved your work. 

 Select your report and click Open. 

 

Resave the Document 

 Click the File tab and select Save As. 

 Change the file name to read report. 

 Click Save. 

 

Edit Your Report 

 
 

 

Save the Changes and then Exit Microsoft Word 

 Click Save on the Quick Access Toolbar. 

 Click the File tab and then click Exit. 

 

  

You want the report to be in your own words. Add, delete, 

and change the words to turn the facts into sentences. 
 

Remember to use the thesaurus and dictionary tools to 

help you reword the facts. 
 

When you are finished, use spell check to fix spelling and 

grammar problems. 
 

Remember, spell check will not find all the errors. Read 

your report one more time to make sure it is perfect! 
S
A
M

P
LE
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Editing Tips 

 In your own words. Read the fact on the report. Now type it into your own words. 

 Delete your worries. Do not worry about deleting something important. You saved the 

report as a new document with a new filename, so you still have the original research. 

 Peer edit. Have a friend read over the report to make sure that it makes sense. 

 

 

 

S
A
M

P
LE
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SESSION 4 SKILL REVIEW 

 

Edit the report on the mountain gorilla. 

 

1.  Open Microsoft Word. 

  

2. . Open the document, "Mountain Gorillas" in the Report folder.  

  

3.  Replace the text "Christa Love" with your name. 

  

4.  Delete the underlined words under the Appearance heading. 

  

5.  Use the thesaurus to replace the words survive, isolated, approximately, and inhabit 

under the Population heading. 

  

6.  Rewrite the words under the Food heading to tell about the diet of the mountain 

gorilla. 

  

7.  Save the document as mountain gorillas edit. 

  

8.  Print the document. 

  

9.  Exit Microsoft Word. 

 

 

 

  

S
A
M

P
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Below is a sample of the completed skill review. View the file in the Session 4 Skill Review folder in 

the TechnoReport Resources. 

 

 
 

 

 

 

Mountain Gorilla 

By Student Name 

 

Appearance 

 

Male mountain gorillas reach an average of 6 feet tall and weigh 400 to 500 pounds, making them the 

largest of the great apes. Females are smaller, standing an average of 4 to 5 feet tall and weighing 150 

to 200 pounds.  

 

Habitat 

 

Mountain gorillas can be found only in the forests of Rwanda, Zaire, and Uganda.  

 

 

Family 

 

Mountain gorillas have only one or two babies. When a baby is born it is very tiny and weights only 4 

pounds. A baby gorilla will cling to its mother’s chest. When it is old enough it will ride on her back. The 

baby stays with its mother until it is five years old. 

 

 

Population 

 

Fewer than 650 mountain gorillas live today in two geographically remote populations. About 320 

gorillas dwell in the Virunga volcanoes region of Rwanda, Zaire, and Uganda, while the remaining 

number live in Uganda's Bwindi National Park.  

 

 

Interesting Fact 

 

Males develop a streak of silver hair on their backs when they mature and are called "silverbacks."  

 

 

Food 

 

Mountain gorillas eat roots, leaves, stems of herbs, vines, bark from trees, and shrub-sized plants. Their 

favorite foods are wild celery, bamboo, thistles, stinging nettles, bedstraw and certain fruit. 

 

Threats 

 

The biggest threat to the mountain gorilla is the loss of their habitat. Humans want to use the land where 

gorillas live for farming. Poachers are another threat. They will kill entire family groups to catch infant 

gorillas for zoos. Sometimes the poachers will sell gorilla heads and hands as trophies.  

 

 

Sources 

 

Defenders of Wildlife. Mountain Gorilla. 15 October 2004. 

http://www.kidsplanet.org/factsheets/mountain_gorilla.html 

 

African Wildlife Foundation. Mountain Gorilla. 15 October 2004. http://www.awf.org/wildlives/149 

S
A
M

P
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SESSION 4 EXTENSION ACTIVITY: MAKE AN ANIMAL HABITAT 

 

Animals live in specific habitats because they give them what they need to survive. The place 

where an animal lives must provide food, shelter, water, and safety. Animals have adapted over 

many years to suit their habitats. For example, a duck has webbed feet so it can swim in the 

water, a beak so it can catch fish and feathers to stay dry in the water. A polar bear has fur to 

stay warm in the cold Arctic, white fur to blend in with the snow, and sharp teeth and claws to 

catch food to eat. 

 

Pick a habitat from the list. Draw a newly discovered animal that could live in this habitat. You 

must ensure that the appearance you give it suits the habitat. The animal must be able to catch 

food, make shelter, drink water, and be safe from predators. 

 

Habitat 

 

 Wetlands: bog, fens, marsh, swamp 

 Fresh water: rivers, streams, lakes 

 Salt water: ocean 

 Rain forest 

 Grasslands 

 Deserts 

 Polar lands 

 

 

 

  

S
A
M

P
LE




